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1. Introducing Plant Simulation

Introducing Plant Simulation

Welcome to Tecnomatix Plant Simulation. This chapter provides a short introduction to Plant Simulation
which is intended for the new user of Plant Simulation.

We will create a simple simulation model and explain the underlying concepts of the terms:

Simulation and Animation

• Simulation Properties

• Animation Properties

We also will:

• Create Simulation Models

• Display Simulation Results

You can then Work Through the Tutorial. There we introduce some of the most important objects.

Also consult the Plant Simulation Step-by-Step Help

Getting to Know Tecnomatix Plant Simulation

Modeling the Material Flow

Visualizing the Material Flow

Animating the Simulation Model in 2D and Viewing the Results

Importing Data for the Simulation

Setting Parameters in the Model

Also consult the Plant Simulation Reference Help

What's New

Updating an Old Model to the Current Version

Using HTML Help
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The Objects Reference Help

The SimTalk Reference Help

The Outdated SimTalk Names in 2D

The 3D Reference Help

The SimTalk Access to 3D

The Outdated SimTalk Names in 3D

The Quick Reference Cards

The Add-Ins Reference Help

The Object Libraries Reference Help

Copyright © 2022 Siemens Industry Software Inc. All rights reserved.

This documentation is proprietary to Siemens Industry Software Inc.

This document contains proprietary information and is protected by copyright. No part of this document
may be reproduced, stored in a retrieval system, translated, transcribed, or transmitted, in any form or
by any means, without the prior explicit written consent of Siemens Industry Software Inc. Information
in this document is subject to change without notice.

Simulation and Animation

Simulation and Animation

As a general rule simulation and animation work together and run concurrently in Plant Simulation.

The simulation component simulates the material flows. The material flow objects collect statistics
values during the simulation, which we show in tables and different diagrams and from which we can
draw conclusions according to the defined targets.

We explain the:

• Simulation in Plant Simulation

• Simulation Properties

The animation component shows the simulated material flows during the simulation in a graphically
pleasing and clear way.

1. Introducing Plant Simulation
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We explain the:

• Animation in Plant Simulation

• Animation Properties

Go to Create Simulation Models

Go to Display Simulation Results

Back to Introducing Plant Simulation

Simulation in Plant Simulation

According to VDI (Verein Deutscher Ingenieure, Association of German Engineers, Directive 3633, Blatt
1, 1993) we run simulations to emulate a system, including its dynamic processes, in a model one can
experiment with, to achieve results that can be transferred to a real world plant.

In our material flow simulations we want to identity the optimum of capacities, resource utilization, and
buffer sizes so that the installation produces the required output.

To do so, we, for example, check the utilization of the machines, their processing, set-up, and failure
times; we identify bottlenecks in the production process, we optimize the layout of the installation, to
find out the optimal dimensioning of the materials-handling technology, etc.

We control the simulation with the simulation properties on the tabs of the dialogs of the material
flow objects, the resource objects, the mobile objects, and the fluid objects. We open the dialogs of
the objects by double-clicking their icon.

Simulation in Plant Simulation
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Simulation and Modeling Concepts and the subtopics What is Simulation?, Time-Oriented
Simulation and Event-Controlled Simulation, Why Employ Simulation?, and Implement a
Simulation Project in the Step-by-Step-Help describe this in detail.

We also offer a short tutorial. The model files are located in the Plant Simulation installation folder >
Plant Simulation > Tutorial, compare the example below.

1. Introducing Plant Simulation
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The topic Working Through the Tutorial guides you through the individual modeling steps.

Back to Simulation and Animation

Simulation Properties

We can set the simulation properties of the objects on the tabs of the dialogs of the material flow
objects, the resource objects, the mobile objects, and the fluid objects. To do so, we double-click the
icon of the respective object in the Frame named Model.

Simulation Properties
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We can set these and additional settings for the simulation of the material flows:

• Times on the tab Times.

• Set-up properties on the tab Set-Up.

• Interruptions (failures, pauses) on the tab Failures.

• Controls, which react on events during the simulation, on the tab Controls.

• Exit behavior, which controls the material flow, on the tab Exit.

In principle you can do this in Plant Simulation

• Change Values in the Dialog of the Objects

• Change Values in the Dialog Show Attributes and Methods

• Change Values by Assigning a Value in SimTalk

1. Introducing Plant Simulation
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We can change to the animation properties by clicking the 3D button . This opens the dialog Edit

3D Properties.

Back to Simulation and Animation

Animation in Plant Simulation

Plant Simulation animates the simulation model automatically, in 2D, compare Animate the Simulation
Model in 2D and View the Results, as well as in 3D, as we show below.

The animation visualizes the material flow/parts flow through the installation and thus allows to track
the journey of the parts. In addition you can replace the graphics of the material flow objects with
graphics of your machines and then animate these graphics with poses to make them look more
realistic.

This makes it easier to understand the processes and procedures in the model for the modeler and for
managers or customers who are to be convinced of the simulated solution.

If we do not need the animation or would like the simulation to run faster, we can deactivate the

animation by clicking .

We can set the animation properties of the objects in 3D by clicking the respective object once in the
model window and by then pressing the spacebar. If the dialog with the simulation properties is open,

we can click  to open the dialog Edit 3D Properties.

Animation in Plant Simulation
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Note:

We recommend to always activate Real time in the EventController in your 3D model as the
simulation runs faster in principle in a 3D Only model as Plant Simulation does not have to
compute the animation events for 2D.

Back to Simulation and Animation

Animation Properties

We can set the animation properties of the objects in 3D by clicking the object once in the model
window and by pressing the spacebar.

1. Introducing Plant Simulation
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We can set these and additional settings for the animation of the material flows in the dialog Edit 3D
Properties:

• The position, rotation, and scaling of the objects on the tab Transformation

• The appearance of the parts on the tab Appearance of the MUs

• The appearance of materials-handling equipment on the tab Appearance of the length-oriented
objects

• Color the animation object on the tab Material

• Define animation paths for:

• MU Animations on the tab MU Animation

• Animations of the objects on the tab Self Animation

• The animation of the robot arm on the tab Robot Arm Animation

• Poses of the objects on the tab Poses

Animation Properties
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• Joints of the objects on the tab Joint

In principle you can do this in Plant Simulation

• Change Values in the Dialog of the Objects

• Change Values in the Dialog Show Attributes and Methods

• Change Values by Assigning a Value in SimTalk

We can click the  button to change to the simulation properties of the objects.

Back to Simulation and Animation

Creating Simulation Models

Create a Simulation Model

We proceed as follows to create our simulation model:

• We start Plant Simulation.

• We click Create New Model on the tab Start.

1. Introducing Plant Simulation
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• Now Plant Simulation shows a dialog an, in which we can select if we would like to create the
simulation model in 2D or in 3D.

Create a Simulation Model
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Generally we always recommend to create the models in 3D. This way you always have a model
that shows a graphically pleasing and good-looking visualization of the material flow and that clearly
resembles the actual look of the modeled installation.
A 2D model is ideal if the visualization of the material flow is not that important for you and if you are
mainly interested in the statistical data that the material flow objects collected.

• We create our model in 3D. By default we model in three-dimensional space.
If you prefer to model in top view, i.e., in two dimensions, change to the View tab and click Planning

View .

• Now we can start modeling. We insert the required material flow objects from the tab Material Flow
in the Toolbox. These objects simulate the flow of the parts through our installation.

Note:

Drag the mouse over an object in the Toolbox to show a Tooltip with the object name.

Click the object with the left mouse button. Drag the mouse to the position of your choice in the
Frame named Model and click the left mouse button once.

• A Source  produces the part which the stations process or convey between the stations.

1. Introducing Plant Simulation
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• A Station  doing the rough-processing of the parts.

• Two additional Stations which further process the parts.

• A PickAndPlace robot  which places the arriving parts to the conveyor.

• A Conveyor  which moves the parts to the Drain.

• A Drain  which removes the parts from the installation.

Then we have to connect the inserted objects so that the parts can flow between the stations. To

do so, we hold down the Ctrl key, click the Connector  in the Toolbox, drag the mouse to the

Frame named Model, and click on the objects one after the other.

The finished model looks like this:

Create a Simulation Model
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We can now run a simulation with an appealing animation with the factory settings.

Click Start/Stop Simulation on the Start ribbon tab.

We also hide the grid on the View ribbon tab as it is only intended as a modeling help.

To better see the effects of changed simulation properties, we also insert a Chart which clearly shows
the changed settings.

To do so, we press Ctrl+A to select all objects in the Frame. As we are only interested in the material
flow objects, we then hold down Ctrl and click the EventController, the Source, the Drain, and the Chart
to deselect them. Then we drag the selected objects onto the icon of the Chart and drop them there. We
select Resource Statistics in the dialog Statistics Type.

After the simulation did run, we can click the Chart with the right mouse button and select Show. The
standard settings of the objects provide these results:

1. Introducing Plant Simulation
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The Station is working 100 % of the time, the following Stations are working 50 % of the time each,
Robot and Conveyor are working 100 % of the time.

After having run the simulation with the factory settings of simulation and animation, we can:

• Change Simulation Settings

• Change Animation Settings

Compare the video Creating a Simple Model under Window > Start Page > Getting Started > Videos.

Compare Working with the Frame

Compare Modeling the Material Flow

Back to Simulation and Animation

Go to Display Simulation Results

Create a Simulation Model
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Back to Introducing Plant Simulation

Change Simulation Settings

We can change the simulation settings of the objects to simulate different scenarios with changed
values.

• We can, for example, increase the processing time of the Station located at the top, named Station1,
from 10 seconds to 2 minutes.

The changed processing time has these effects:

1. Introducing Plant Simulation
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The working portion of the Station fell to 70 %, while it rose for the following Stations, the Robot is
now waiting for parts and the Conveyor is now 100 % of the time again.

• We then increase the time factor of the PickAndPlace robot from 1 to 2.

Change Simulation Settings
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The changed time factor has these effects:

1. Introducing Plant Simulation
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The working portion of the Station and the following Stations fell, the Robot is working 100 % of the
time again, the working portion of the Conveyor did not change.

Go to Change Animation Settings

Back to Creating Simulation Models

Change Animation Settings

After the simulation settings we are going to change some of the animation settings:

• For the Conveyor we select another configuration so that it resembles the conveyor in our installation.
To do so, we click on the Conveyor once with the left mouse button and press the spacebar.
Instead of the default belt conveyor we use a roller conveyor with arched T-based legs spaced 1.5
meters from each other. It then looks like this:

• As our white part is hard to see during the simulation, we change its color. As we want to do this for
all produced parts, we edit the Class of the Part.
To do so, we change to the Class Library, open the folder MUs, and double-click the Part. This opens

the dialog of the simulation settings. There we click  to open the dialog of the animation

settings. There we can activate the material of the Part and select brown as color.

Change Animation Settings
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When we then run the simulation, we see that our part now has the color we selected, namely brown.

• Next, we replace the graphic of our robot so that it matches the robot in our installation:

1. Introducing Plant Simulation
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• We click the robot with the right mouse button and select Exchange Graphics.

• We select the Comau PickAndPlace robot.

Change Animation Settings
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• As the robot is too far away from the feeding Stations, we adjust the positions as shown below.
Drag a marquee around the robot, the Conveyor, and the Drain and press the Left arrow key until
the position fits.

Animating the Robot Arm in 3D shows how to prevent that the robot arm moves through the
protective cover and the parts holder and moves above both.

1. Introducing Plant Simulation
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• As we do not like the position of the EventController, the clock lying flat on the floor, we change that
as well. To do so, we click the EventController with the left mouse button and press the spacebar.
The standard settings on the tab Transformation look like this:

We changed these settings:

• We moved the Z position of the EventController up to 5.4 meters.

• We rotated the clock by 90 degrees forward on the X axis. To do so, we typed in 90 as angle and
clicked the button next to X axis.

The clock now hangs on the rear wall of the installation with the face facing forward.

Back to Change Simulation Settings

Back to Creating Simulation Models

Change Animation Settings
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Displaying Simulation Results

Display Simulation Results

After Plant Simulation has executed the simulation run, we can show and analyze the simulation results.
To do so, we use Display and User Interface Objects.

We inserted a Chart, a SankeyDiagram, and an HtmlReport each. We use these objects with their
respective standard settings.

• The Chart shows resource statistics of the material flow objects which we selected.
After we executed the simulation, we click the Chart with the right mouse button and select Show.
The standard settings provide these results:

1. Introducing Plant Simulation
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• The SankeyDiagram shows the flows of parts through the installation with arrows in different
widths. We see that more parts take the route across Station2 than Station1.

• The HtmlReport shows general information about the simulation model and state statistics and
Drain statistics values.

Display Simulation Results
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• In addition each object shows the most important values on its tab Statistics.
In the dialogs of the objects you can display What's This Help for the individual dialog items. To do so,
click the question mark on the title bar of the dialog window and then on the dialog item for which
you need help. What's This Help shows a description of the dialog item and the name of the
programming command with which you can set or query it.

1. Introducing Plant Simulation
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Finally we execute a simulation run with deactivated animation. Then Plant Simulation neither shows
the parts nor the movement of the Robot during the simulation.

To do so, we can click Start Fast Forward Simulation  and watch how much

faster the simulation runs without animation.

Display Simulation Results
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Simulation with animation Simulation without animation

To better see that we only simulate for 24 hours. To do so, we type in an end time of 24 hours on the
tab Settings of the EventController.

1. Introducing Plant Simulation
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The results of the simulation run without animation are the same as those of a simulation run with
animation. The statistics values, which the Drain collected, show this:

Simulation with animation Simulation without animation

Display Simulation Results
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Simulation with animation Simulation without animation

Compare these topics in the Step-by-Step Help:

Animate the Simulation Model in 2D and View the Results

• Viewing and Visualizing Statistics

• Viewing Statistics in the Dialogs of the Objects

• Showing Statistics in a Chart

• Viewing the Statistics Report

• Showing Statistics and Other Values in a Report

• Show Values with the Display

• Showing Part Flows in a SankeyDiagram

• Showing Parts on Resources in a GanttChart

1. Introducing Plant Simulation
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Back to Simulation and Animation

Back to Creating Simulation Models

Back to Plant Simulation for Beginners

Working Through the Tutorial

Work Through the Tutorial

The built-in tutorial introduces you to modeling in Plant Simulation. It is short and yet comprehensive
enough to get you started with creating and executing simulation models in Plant Simulation. If you
have not already done so, we recommend that you familiarize yourself with the Plant Simulation user
interface, with the Ribbon Bar, and with the objects in the Class Library and the Toolbox.

In our tutorial model we create a testing line for monitors and for game consoles. We will first create a
testing station before adding two stations to the main line. Monitors and game consoles will enter the
processing line, will be put into containers, moved across a line to a pre-testing station, then to the main
testing station, before being packed and shipped.

Creating the entire model is quick and easy. You can, however, save your models and return to them at a
later point in time. The respective model files are located in the Plant Simulation installation folder >
Plant Simulation > Tutorial, compare the example below.

Work Through the Tutorial
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Go to Tutorial Part 1

Go to Tutorial Part 2

Go to Tutorial Part 3

Back to Introducing Plant Simulation

Tutorial Part 1

Tutorial Part 1

In part 1 of our tutorial we will create a folder for our simulation model, name it TestingLine, and build a
basic test station for the production line.

Proceed as follows to create a new Folder and a new Frame.

• Click Create New Model on the Start Page to create a new model.

1. Introducing Plant Simulation
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• Click 3D in the dialog, which Plant Simulation shows, to create the simulation model in 3D.

• Click the object Basis at the very top in the Class Library with the right mouse button and select New
> Folder.

• Click the new folder with the right mouse button, select Rename, and rename it to TestingLine.
We now created the folder in which we store our simulation models.

Next, we will create a new Frame. The Frame is the container in which we build our simulation models.

• Click the folder TestingLine in the Class Library with the right mouse button and select New > Model
Frame.
This creates a Frame that does not show its contents towards the outside and that contains an
EventController for running simulations.

• Click the Frame with the right mouse button, select Rename, and rename it to Test.

• Double-click the Frame named Test to open it.
Now we have created our first Frame, named Test, for the testing line for the monitors and the game
consoles. We can insert the stations that we need.

Tutorial Part 1
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Go to Tutorial Part 2

Go to Tutorial Part 3

Model the Receiving Department with the Source

The first object that we’ll insert into our simulation model is the Source. It produces the parts, in our
case the monitors and game consoles, which will be moving through the production system. The Source
might, for example, represent the machines that produce the parts in the plant or the receiving
department of the plant.

• Double-click the Frame named Test to open it.
As it is easier to insert the objects in top view, i.e., in two dimensions instead of in three, change to

the tab View and click Planning View .

• Click the Source  on the tab Material Flow in the Toolbox.

• Move the mouse over the Frame and click the left mouse button on the left side of the Frame to insert
it. You can zoom the contents of the Frame by rolling the mouse wheel.

1. Introducing Plant Simulation
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By default Plant Simulation does not show the names of the objects. Sometimes this is helpful while
modeling though. Click the object with the left mouse button and press the spacebar. Click the tab
Captions and activate Name/Label enabled.

Model the Receiving Department with the Source
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You have to repeat this for each object whose name you would like to show.

To hide displayed object names in the 3D window again, click Show Object Names  on the

View ribbon tab.

Model the Processing Stations with the Station

Next, we will insert two objects of type Station. The Station is a generic object which represents any
station or machine on which parts spend a certain amount of time to be processed.

• Click the Station  on the tab Material Flow in the Toolbox.

1. Introducing Plant Simulation
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• Move the mouse over the Frame named Test.

• Hold down Ctrl and insert one Station to the right of the Source and a second one to the right of the
first Station.

• Click the second Station with the right mouse button and rename it to Testing.

Model the Shipping Department with the Drain

The last object we need is an object of type Drain. The Drain removes the parts from our plant. It might,
for example, represent the shipping department of our plant.

• Click the Drain  on the tab Material Flow in the Toolbox.

• Insert it to the right of the Station named Testing.

Model the Shipping Department with the Drain
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Connect the Material Flow Objects with Connectors

Now that we have inserted the objects we need for our first project, we have to connect them with the
Connector. The Connectors determine how the parts move through our plant. The parts move through
the plant in the sequence in which you connect the objects.

• Select the Connector  on the tab Material Flow in the Toolbox to activate connect mode.

• Click the Source with the left mouse button. It is the starting point of the connection.

• Next, move the mouse over the icon of the first Station, the first target object, and left click to
connect the two objects.

• Repeat this for all objects within the Frame named Test.

1. Introducing Plant Simulation
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Note:

To connect several objects one after the other, hold down Ctrl before you click on the Connector
in the Toolbox.

We can now test the model by running a simulation with the EventController.

Run the Simulation with the Event Controller

You can start, stop and reset the simulation with the EventController. You can also control the speed of
the simulation.

Double-click the icon of the EventController  to open its dialog window.

• Click Start/Stop Simulation  to run the simulation.

You will notice that the Source produces the parts, that they are then moved on to the Stations, are
tested in the Station named Testing, and exit the plant via the Drain. If you reduce the simulation
speed a bit, by dragging the Faster/Slower slider to the left, you can see this better.

Run the Simulation with the Event Controller
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Note:

We recommend to always activate Real time in the EventController in your 3D model as the
simulation runs faster in principle in a3D Only model as Plant Simulation does not have to
compute the animation events for 2D.

• Click the buttons Start Simulation  and Reset Simulation  to stop the simulation and to

reset your simulation model.

1. Introducing Plant Simulation
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As we have finished modeling the first part of the tutorial, we can deactivate Planning View and the
Grid on the View tab of the ribbon bar and thus display the model in three-dimensional space.

You can move the scene with the mouse and zoom it with the mouse wheel.

Select Distributions for Processing and Production Times

We will now change the processing time of the Station Testing from the default time of 1 minute to a
probability distribution, let’s say the Normal distribution. This way the processing time for each part
will be based on a random number according to the Normal distribution.

Select Distributions for Processing and Production Times
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• Open the dialog window of the Station Testing and click the tab Times.

• Select the Normal distribution from the drop-down list Processing time.

• Type in 0:55, 0:05, 0:01, 1:30 as the Processing time.

Plant Simulation shows the parameters, which this distribution requires, above the text box.
In Plant Simulation we separate seconds from minutes with a colon (:). So 1:30 stands for 1 minute
and 30 seconds, compare Enter Times.
The processing time for the station named Testing now follows the Normal distribution with a
mean value of 55 seconds and a standard deviation of 5 seconds.

Next, we’ll select a distribution in the Source according to which it produces the parts.

• Open the dialog window of the Source.

• Change the Interval to the Negexp distribution on the tab Attributes.

• Type in a distribution time of 1:00 minute.

1. Introducing Plant Simulation
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To allow us to see if the parts and stations are blocked during the simulation, we select File > Model
Settings > 3D and activate Show states as colors if no state graphics are present.

Run the simulation again. You will notice that the parts now sometimes are yellow. This means that the
parts are blocked, i.e., they cannot move on to the following target station because it is still occupied by
the preceding part.

This is an issue we need to solve.

Buffering Parts to Prevent the Material Flow Slowing Down

As we have created a potential bottleneck within the model, we will insert a Buffer between the Source
and the station named Testing to prevent the material flow from grinding to a halt. The Buffer stores
parts if the following components or machines fail.

Buffering Parts to Prevent the Material Flow Slowing Down
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• Delete the first Station .

• Select the object Buffer  on the tab Material Flow in the Toolbox and replace the Station with

the Buffer.

• Connect the Source with the Buffer and the Buffer with the station named Testing. The new sequence
of stations now is Source - Buffer - Testing.

Instead, you an also hold down the Alt key, select the Buffer drag it over the Station in the Frame and
drop it there. When you proceed like this, the Connectors are retained, meaning you do not have to
reconnect the objects. Click No in the dialog that will be opened.

1. Introducing Plant Simulation
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• Open the dialog window of the Buffer and change to the tab Attributes. Change the Capacity from 8
to 20.

• Apply the changes and close the dialog window.

When you now run the simulation, you will notice that the Buffer holds more than one part. Rather than
being blocked immediately, it accumulates parts to a maximum of 20 parts. Once it reaches the capacity
of 20, it will not allow any more parts to enter until a part has moved on to the station named Testing.

Buffering Parts to Prevent the Material Flow Slowing Down
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Buffering parts within the production line shows how you can use the Buffer.

Show the Number of Parts in the Buffer with the Chart

We will now insert a Chart into the model to view the number of parts that are located in the Buffer
during the simulation run.

• Click the object Chart  on the tab User Interface in the Toolbox.

• Insert the Chart above the Buffer.

• Drag the Buffer onto the Chart and drop it. Make sure that Occupancy is selected in the dialog
Statistics Type. Click OK.

1. Introducing Plant Simulation
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• The Chart window opens as a histogram.

• Click Reset Simulation  and Start/Stop Simulation  in the EventController to reset the

simulation model and to start the simulation.

• Save your simulation model.

The histogram shows how many parts were located in the Buffer during which percentage of the time.

Show the Number of Parts in the Buffer with the Chart
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If you closed the display window of the Chart, click it with the right mouse button, and select Show on
the context menu.

Showing statistics in a chart shows how you can use the Chart.

Tutorial Part 2

Tutorial Part 2

If you have not completed Part 1 of the tutorial, you can open the respective tutorial model from the
Plant Simulation installation folder > Plant Simulation > Tutorial, compare the example below.

1. Introducing Plant Simulation
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We will start this part of the tutorial by creating another Frame within our folder TestingLine. Here we
also insert a Source, a Drain and several Stations. We will also be using the Frame named Test, which we
created in Part 1 of the tutorial.

• Create a new Frame is described in Part 1.

• Click the folder TestingLine in the Class Library with the right mouse button and select New > Glass
Box Frame. This creates a Frame that shows its contents towards the outside, but not its default
graphic and its caption.

• Rename the new Frame to ProcessingLine.

Tutorial Part 2
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• Double-click the icon of the Frame named ProcessingLine. As we do not need the graphic Under
Construction of the Frame, we delete it.

We will now insert the objects which we need into the Frame named ProcessingLine.

• Insert a Source .

• Insert a Station  and rename it to PreTest.

• Open the dialog window of the Station named PreTest.
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• On the tab Times select NegExp as the Processing time.

• Type in 1:00 as the Processing time.

• Insert a Drain .

Next, we will insert the two Frames named Test, which we created in Part 1, between the station named
PreTest and the Drain.

• When we insert our Test Frame, we see that it shows its caption. It does not show its content during
the simulation though.

For this reason we change the type of the Test Frame from Model Frame to Glass Box Frame.

• Click the Frame named Test in the Class Library with the right mouse button and select Edit 3D
Properties.

• Change to the tab Captions and clear Name/Label enabled.

Tutorial Part 2
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• Change to the tab Graphics, select Show content and clear Visible for the graphic group named
default.

• Click the Frame named Test in the folder TestingLine.

• Drag it between the station PreTest and the Drain, and drop it there.

• Rename this Frame to Test1. As Test1 shows its content, we see all of the stations contained
within, namely the Buffer, the station named Testing, and the Chart.

• To create a second Test Frame, hold down the Ctrl key, move the mouse over the Frame named Test1,
and click the left mouse button.

• Drag Test1 downwards and drop it. If you cannot see the derived Frame, scroll down in the Frame
ProcessingLine.
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• Rename this Frame to Test2.

Back to Tutorial Part 1

Go to Tutorial Part 3

Working with Inheritance of Object Classes

Before we can connect and run this model, we have to edit the Test objects. To do this, we will edit the
object Test in the Class Library. Editing the class object automatically propagates our changes to all of its
instances in our simulation model, Test1 and Test2 in our example.

• Open the Frame named Test in the Class Library.

• Delete the Source, the Drain, and the EventController from the Frame named Test.

You will notice that this also deleted the Source, the Drain, and the EventController from the Frames
named Test1 and Test2.

Working with Inheritance of Object Classes
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Related Topics

Inheritance

Using Inheritance

Modeling Hierarchically

Introducing Classes

Working with Classes in the Class Library

Model Transitions between Frames

We will now insert two Interface objects in place of the Source and the Drain into the Frame named
Test. Interface objects determine where the flow of materials enters and exits a Frame.

• Click the Interface  on the tab Material Flow in the Toolbox.
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• Insert the first Interface in place of the deleted Source.

• Insert the second Interface in place of the deleted Drain.

• Click the Connector in the Toolbox.

• Connect the first Interface with the Buffer.

• Connect the station Testing with the second Interface.

• Close the Frame.

When you open the Test Frames inside of the model ProcessingLine, you will detect that the Source and
the Drain have been replaced with Interface objects in both objects. This is known as Inheritance. It is a
crucial feature when creating simulation models in Plant Simulation.

In the next step we connect all objects within the Frame named ProcessingLine using the object
Connector.

Model Transitions between Frames
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• Click the icon of the Connector  in the Toolbox.

• Connect all the objects so that your model matches the screenshot below.

• First connect PreTest with the Interface of the Frame Test1 that is located on top.

• Then connect PreTest with the Interface of the Frame Test2 that is located on top.

• Finally connect Test1 with the Drain and then with Test2.

• Insert an EventController.

We can now run the simulation with the EventController. You will notice that the Test Frames behave
like any other object within the model. When you open the Test Frames however, you can view the
activities of the parts within the Frames.

By default we do not show Information Flow Objects and User Interface Objects in the simulation model
as we are mainly interested in the material flows. For this reason we do not see the Chart when we
insert our Frame named Test into the processing line. To show the Chart, clear the check box Exclude
from "Show content" of the location. If you do not want to show the Chart any longer, select the check
box again.
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Sometimes it is helpful to show the Chart at a small scale in the Frame instead of its icon, for example to
grasp the occupancy of the Buffers at a glance. To do so, double-click the Chart in the Frame named
Test. Change to the tab Display and activate Display in frame.

If you do not need this view any longer, clear the check box again.

Model Transitions between Frames
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Distribute the Flow of Materials with an Exit Strategy

In this step we will use an exit strategy to distribute the flow of materials. We are going to distribute
the flow of materials so that 60 % of the parts move to the station Test1 while the remaining 40 % move
to the station Test2.

• Open the dialog of the station PreTest and change to the tab Exit Strategy.

• Select Percentage from the drop-down list as the Strategy and select the check box Blocking. Then
click Apply.

• Click the button Open List below the drop-down list box Percentage.

• Type 60 into the first row, press the Enter key, then type in 40 into the second row. This means that
60 % of the parts move to the successor with the number 1 and 40 % to the successor with the
number 2.
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• Click OK to apply your changes and to close the station named PreTest.

When you now run the simulation and analyze the Charts in the two Test stations, you will notice that
more parts are processed in the station Test1 than in the station Test2. This is caused by the distribution
we entered into the Percentage table of the station PreTest.

Distribute the Flow of Materials with an Exit Strategy
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Note:

If it is the other way round, namely more parts are processed on the station Test2 than on the
station Test1, delete the Connectors between PreTest and the Test stations. Then first connect
PreTest with Test1 and then PreTest with Test2. The test station which you connected first to the
PreTest station is successor number 1, the station which you connected after that with the PreTest
station is successor number 2. Successor number 1 is always served before successor number 2.

Model Conveyors

Now we are going to insert an object of type Conveyor into our simulation model. It represents a
conveyor feeding parts to the testing stations. First, delete the Connector between the Source and the
Station PreTest. To fit the Conveyor between the stations, you might have to move the rest of your
objects to the right. Drag a marquee across all objects to select them. Then, move them to the right with
the right arrow key. To move them by an entire grid unit at a time, hold down Shift and press the right
arrow key.
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• Select the Conveyor  on the tab Material Flow in the Toolbox.

• Insert the Conveyor between the Source and the station PreTest.

• The first mouse click determines the starting point, the second click sets the end point of the
Conveyor.

• Connect the Conveyor with the Source and the station PreTest.
If you have trouble connecting the Conveyor, move it down with the down arrow key, connect it with
the Source and with the station PreTest, and then move it up again with the up arrow key.

Model Conveyors
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Count Parts on the Conveyor with Variable and Method

When you run the simulation, you will see the parts moving along the Conveyor to the station PreTest.
To count the parts entering the Conveyor, we will insert a sensor at the beginning of the Conveyor. We
will then use a Method to make Plant Simulation increase a counter in a Variable whenever a part
passes the sensor.

You can write source code in a Method to define special behavior which cannot be set by selecting or
entering settings into the dialogs of the objects. Plant Simulation provides the proprietary programming
language SimTalk for this purpose.

Insert a Method  from the tab Information Flow in the Toolbox below the object Conveyor.

• Click the Method with the right mouse button and rename it to counter.

• Open the dialog window of the Conveyor.

• Click the tab Controls.

• Click Sensors.
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• Click New and enter 0 as the Position of the sensor. This places it at the start of the Conveyor.

• Click the button in the text box Control, select counter and then click OK.

Count Parts on the Conveyor with Variable and Method
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• Close the dialog Sensor List.

• Click OK again to apply your changes and to close the dialog window of the Conveyor.

• Double-click the method counter.

• Copy the following source code and paste it into your method. To do so, select the text, then click it
with the right mouse button and select Copy on the context menu, or press Ctrl+A, Ctrl+C, and then
Ctrl+V.

NumberOfDevices := NumberOfDevices + 1

• Apply the source code by clicking the button  on the Edit ribbon tab and then close the method

window.

Insert a Variable  into your simulation model from the tab Information Flow in the Toolbox above
the Conveyor.
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• Double-click the Variable and name it NumberOfDevices. Select the check box Initial value and
enter the value 0. This way the value of the Variable is automatically set to 0 when the simulation
starts.

• On the tab Display select the Font size > Large. If you want to, you can also select a different color.
We selected blue.

• Save your simulation model.

Run the simulation to watch the parts moving along the Conveyor triggering the sensor and increasing
the counter. To better follow the simulation, decrease the simulation speed in the EventController.

Count Parts on the Conveyor with Variable and Method
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Save your simulation model.

Tutorial Part 3

Tutorial Part 3

If you have not completed Part 2, you can open the respective tutorial model from the Plant Simulation
installation folder > Plant Simulation > Tutorial, compare the example below.
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In this part we will insert a second Source to produce Containers. We will also insert the object
AssemblyStation to load parts onto the Containers before the parts are processed. In doing so, you
might have to move the objects in the Frame a bit to the right.

• Insert another Source  below the existing Source in the Frame named ProcessingLine.

• Click the new Source with the right mouse button and rename to SourceContainers.

• Click the ellipsis button in the text box MU on the tab Attributes and select the object Container in
the folder MUs in the Class Library. This way we tell the Source to produce containers.

Tutorial Part 3
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Back to Tutorial Part 1

Back to Tutorial Part 2

Load Containers

To load parts on the objects of type Container :

• Drag the object AssemblyStation  from the tab Material Flow in the Toolbox on the Connector

between the Source and the Conveyor and drop it there. This way you don’t have to delete the
Connector between the Source and the Conveyor and insert it anew.
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• Rename the station to LoadingStation. Connect the SourceContainers with the LoadingStation.

• Double-click the LoadingStation and select the Assembly mode > Attach MUs on the tab Attributes.
Change to the tab Times and type in a Processing time of 50 seconds, i.e., 0:50.

As the AssemblyStation is connected to two stations, the order in which you connect it with the
predecessors is important. If the assembly process does not work as expected, check the numbering of
the predecessors by dragging the mouse over the Connector and viewing the Tooltip.

Load Containers
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In our case we entered 2 into the text box Main MU from predecessor as only the transporting part
from the predecessor with the number 2 can take on parts.

Specify the Parts to be Produced in a DataTable

Specify the Parts to be Produced in a DataTable

Next, we will introduce a second type of MU, rename the types to Monitor and VideoGameConsole,
and use a DataTable to set the percentage of each part that will be tested in the model.

• Insert a DataTable  from the tab Information Flow in the Toolbox above the Source.

• Click the DataTable with the right mouse button and rename it to ProductData.

• Open the dialog window of the Source.

• Select Random as the MU selection on the tab Attributes.

• Click  and select the table ProductData in the text box Table.
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• Click OK to apply your changes and to close the window.

Specify the Parts to be Produced in a DataTable
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Edit the Product Data

Plant Simulation automatically formatted the DataTable named ProductData to serve as the distribution
table for the Source. We will now type in Monitor and GameConsole as the products that we are
going to process.

• Open the DataTable named ProductData.

• Select the object Part  in the folder MUs in the Class Library. Drag this object to row 1 of the
column MU of the table ProductData and drop it there.

• Enter 70.00 into row 1 of the column Frequency.

• Enter Monitor into row 1 of the column Name.

• Drag the object Part from the Class Library to row 2 of the column MU and drop it there.

• Enter 30.00 into row 2 of the column Frequency.

• Enter GameConsole into row 2 of the column Name.

1. Introducing Plant Simulation

1-72  , Plant Simulation 2201
© 2022 Siemens



• Click outside the table cell which you just edited and close the table.

• Once you run the simulation, you will see that the Source produces 70 % monitors and 30 % game
consoles for testing.

The next step will be to separate these two devices after they have been tested in the Testing stations
and to record the amount of each that have been tested within a DataTable.

To do so, we will program another control to separate the monitors and game consoles after they have
been tested, and record the amount of each of these devices in a table.

• Click the Drain with the right mouse button and rename it to Monitors.

• Delete the Connectors between the stations Test1 and Test2 and the Drain.

• Insert a second Drain below Monitors and rename it to GameConsoles.

• Insert a Station between the Testing stations and the two Drains.

• Click the Station with the right mouse button and rename it to Packing.

• Connect all objects and move the LoadingStation and the Conveyor to the left.

Edit the Product Data
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When you run the simulation now, you will detect the default behavior of the Station, namely that the
parts, on leaving the station Packing, alternate between the two Drains. We need to separate the
monitors from the game consoles and send them to their respective Drain though. We accomplish
this by using a Method as an exit control in the station Packing.

• Insert a Method  below the Station named Packing.

• Rename this Method to packingControl.

• We entered the following source code:

if @.cont.name = "Monitor" // move monitors to Drain named Monitors
   @.move(Monitors)
else
   @.move(GameConsoles)    // move game consoles to Drain named 
GameConsoles
end

• Open the Station named Packing and click the tab Controls.

• Click the button in the text box Exit and select the Method named packingControl.
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• Click OK to apply your changes and to close the window.

After the parts have been processed on the Station named Packing, they are sorted by the Method
named packingControl and are sent on to their respective Drains.

Replace the Pallet with a Transport Box

As the pallets on the conveyor and on the stations do not look realistic for our purpose, we change the
graphic of the Container. As we want to do this for all Containers, we do it in the object class.

• Open the folder named MUs in the Class Library.

• Click the Container with the right mouse button and select Open in 3D.

• Click into the background of the window and select Exchange Graphics.

Replace the Pallet with a Transport Box
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• We selected the transport box named BoxFor2x1x2Entities.s3d and clicked Yes in the dialog that
was opened afterwards.
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This then looks like this:

• When we run the simulation, we see that an empty transport box that moves onto the
LoadingStation, overlaps the loaded transport box that is already located there.

Replace the Pallet with a Transport Box
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• To fix this problem, click the LoadingStation and press the M key, Show Manipulators. Click the left
border of the LoadingStation and press the Left arrow key until the transport boxes do not overlap
any longer.

Then you have to move the Source to the left to make the positions fit again, as we changed the
width of the LoadingStation. Now everything looks as it should.
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Record Simulation Results in a DataTable

To finish our simulation model, we will insert a DataTable to record the ratio of the monitors to DVD
players that have been tested.

• Insert another DataTable  on the top right side of our ProcessingLine.

• Rename the DataTable to Results.

• Select the entire table by clicking the button in the top left corner of the cell grid.

• Then, click the right mouse button on the Select All button, select Format, and change the data type
of the cells to Integer.

• Click OK to apply these changes.

• Now click Activate Column Index in the ribbon tab List.

Record Simulation Results in a DataTable
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• We have now activated the column index, i.e., the column header into which we can enter our
product names.

• Enter Monitors into row 0, to the right of string, of column 1.

• Enter GameConsoles into row 0 of column 2.

• Click in an empty cell and close the table.

The Results table can now record the amount of monitors and game consoles that have been tested by
the TestingLine. The next step will be to modify the exit control named packingControl of the Packing
station to record the results.

• Open the Method named packingControl.

• Edit the source code as follows:

if @.cont.name = "Monitor" 
   @.move(Monitors)
   Results["Monitors",1] += 1
else
   @.move(GameConsoles)
   Results["GameConsoles",1] += 1
end

Note:

You can also insert the column numbers in place of the index headings Monitors and
GameConsoles.
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• Click Apply Changes  on the Edit ribbon tab.

When you run the simulation, the amount of monitors and game consoles, which have been tested,
will be recorded in the Results table.

At the moment the numbers of the parts in the Results table increase with each and every simulation
run. We would like to delete the contents of the table though when we reset the simulation with the
EventController. To do so, we insert a reset method.

• Insert another Method object.

• Rename the Method to reset (notice how the default icon changes).

• Type in the following source code into the reset method:

Results.delete

• Click Apply  in the Edit ribbon tab of the Method window and close the Method.

Run the simulation and compare the results in the table Results with the total number of parts that the
Variable recorded.

Show Simulation Results in a Chart

We will now insert a Chart to view the number of parts that have been tested by our ProcessingLine.

• Insert a Chart  next to the DataTable named Results.

• Click the DataTable named Results and hold down the left mouse button.

• Drag the DataTable onto the icon of the Chart and drop it there.

• This opens a Chart of the DataTable named Results.

Show Simulation Results in a Chart
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We entered the title Tested Devices on the tab Labels of the Chart.

Click the Chart with the right mouse button and select Show to reopen the display window of the
Chart.

• Save your simulation model.
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Delete the No Longer Needed Interfaces

In the current version sub-Frames that only contain a single material flow object, you do not have to
insert Interfaces, but can connect the sub-Frame directly with its predecessor and its successor in the
surrounding Frames. Connections without Interfaces only work across a single lower hierarchy level, not
across several nested hierarchy levels.

• Open the Frame named Test in the Class Library. Delete the Interfaces named Entry and Interface1.

The model now looks like this:

Delete the No Longer Needed Interfaces
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• Connect the station PreTest with the Buffer in the Frame Test1 and the station Testing with the station
Packing with a Connector each.
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• Repeat this for the Frame Test2.

Delete the No Longer Needed Interfaces
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• Save your simulation model.

This completes our tutorial as we have solved all of our modeling tasks.

Back to Tutorial Part 1

Back to Tutorial Part 2

Back to Tutorial Part 3

Back to Working Through the Tutorial
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